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Chapter

1 Installing RSView32 
Messenger

About RSView32 Messenger
RSView32 Messenger™ is a voice alarm notification, paging, reporting and 
messaging system. It is an add-on to RSView32™.

With Messenger you can announce alarms locally using a computer sound or 
voice card, or over a telephone using a voice card. You can also send alarm 
notification to pagers, fax machines, e-mail addresses, mobliephones or to an 
RSView32 Active Display Client computer. In addition, you can create a 
schedule of alarm notification destinations. This lets you accommodate 
holidays, weekends, and other times when you might want notification sent 
off-site to personnel who are on call.

Messenger alarm notification works with RSView32, extending and enhancing 
its alarm capabilities.  

In addition to announcing alarms with Messenger, you can create messages and 
reports about alarm activity and tag activity. These reports can be sent to the 
same destinations as alarms.

About Messenger Pro
If you purchase an RSView32 Messenger Pro™ license, you can use these 
additional features: 

 Send file attachments with e-mail notifications.

 Dial in using a regular phone line, to hear and respond to alarms, hear status 
phrases, or run RSView32 commands or macros.

You must activate the Messenger Pro license on your run-time system, as 
described later in this chapter.
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System requirements
To run RSView32 Messenger, the recommended requirements are:

 Personal computer (PC) with an Intel® Pentium® processor. 200 MHz or 
faster processor recommended. 300 MHz or faster to use voice card. 

 Memory. 64 MB or more is recommended.

 Hard disk space. Minimum 50 MB.

 Operating system. Microsoft® Windows® Server 2003 R2 Standard Edition 
with Service Pack 2; Windows XP Professional with Service Pack 1 or later;  
Windows  2000 Server with Service Pack 4 or Windows 2000 Professional 
with Service Pack 4; or Windows Vista Business with Service Pack 1 or later 
(32-bit) or Windows Vista Home Basic with Service Pack 1 or later (32-bit); 
Windows 7 Professional (32-bit); and Windows Server 2008 Standard 
Edition Service Pack 2 (32-bit).

 Modem. To communicate with pagers or fax machines, you need a 
Windows-compatible fax-modem. For sending e-mail, either a modem, 
network, or Internet connection is required.

 Sound card. To announce alarms over loudspeakers, you need a Sound 
Blaster®-compatible sound card and speakers.

 Voice card. You must use a voice card to send alarm notification to a 
telephone, or to use dial-in access. Messenger supports the Intel Dialogic 
ProLine/2V,  Intel Dialogic D/4PCI, Intel Dialogic D/4PCIUF, and Intel 
Dialogic D/4PCIU4S voice cards.

The ProLine/2V is an ISA card. Make sure your PC has an ISA slot before 
purchasing this card.

If you use the D/4PCI voice card, Messenger supports channels 1 and 2 on 
the voice card.

 RSView32 software. RSView32 7.60.00

 Microsoft Exchange e-mail. To send e-mail, you need Microsoft Exchange 
e-mail. Other MAPI-compliant e-mail systems might work as well. (MAPI 
is the Messaging Application Program Interface.)

For detailed information about calculating system requirements, see the 
RSView32 Readme file.
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Installing RSView32 Messenger
As part of the installation process, Messenger creates program folders and 
modifies registry entries. In order to make these modifications, Messenger 
must be installed on a Windows computer that is set up with these rights (for 
example, the Windows administrator account has these rights).

Installation steps
The steps below explain how to install Messenger software from a CD-ROM 
to your computer. Before installing Messenger, be sure that RSView32 7.60.00 
is installed on the computer.

1. Close all open Windows programs.

2. Place the RSView32 Extensions CD-ROM in your CD-ROM drive. The 
CD should start running automatically.

If the CD does not start automatically, run D:\Setup.exe where D is the 
drive containing the CD.

3. Follow the on-screen instructions.

4. When installation is complete, restart Windows. If you do not restart 
Windows now, be sure to restart it before running Messenger for the first 
time.

Installation summary
The default installation installs RSView32 Messenger in \Program 
Files\Rockwell Software\Messenger.

Activating RSView32 Messenger Pro 
Rockwell Software uses activation files to activate some of its Windows-based 
software packages. You do not need to activate RSView32 Messenger. 
However, if you purchased an RSView32 Messenger Pro license, you must 
activate it on the run-time computer. 

You can activate RSView32 Messenger Pro by using FactoryTalk Activation 
software to download and transfer activation files.
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FactoryTalk® Activation
FactoryTalk Activation provides a secure, software-based system for activating 
Rockwell Software products and managing software activation files. With 
FactoryTalk Activation, there is no need for a physical “master disk” or any 
physical media; instead, activation files are generated and distributed 
electronically.
Important: EvRSI activation is replaced by FactoryTalk® Activation in this re-
lease. If you are using EvRSI activation, please contact your local Rockwell Au-
tomation Sales office or Technical Support for information on migrating your
activations to FactoryTalk® Activation. For Rockwell Automation Technical
Support in the U.S. call (440 )646-3434. Outside the U.S. see http://www.rock-
wellautomation.com/locations/.

Finding more information about FactoryTalk Activation
You can find detailed information, instructions, and troubleshooting tips in the 
FactoryTalk Activation Help. 

After installing and launching the FactoryTalk Activation software, click Help 
or Learn More . . . to open  FactoryTalk Activation Help.

Using the FactoryTalk Activation Manager
The FactoryTalk Activation tool is used to obtain the activation files needed to 
activate your software. It can also be used to borrow activations from servers 
having available activations, return activations back to servers, re-host 
activations, etc.

To open the FactoryTalk Activation Manager:
On the Windows Start menu, click Programs > Rockwell Software > 
FactoryTalk Activation > FactoryTalk Activation Manager.

To use the FactoryTalk Activation Manager:
1. In the FactoryTalk Activation Manager, click the Home tab then click Get 

New Activations, or you may click Manage Activations tab, then click Get 
New Activations.

2. Select the Activation Method to be used.
To provide the software’s Serial Number and Product Key, identify the 
activation server’s Host ID, and download activation files, follow the 
instructions in the manager.
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3. Save the activation file or files.
Activation files must have a .lic extension. You can save the files to the 
default location:
On Windows 2003 and Windows XP the default location for FactoryTalk 
activation files is:.C:\Documents and Settings\All Users\Shared 
Documents\Rockwell Automation\Activations

4. On Windows 7 Professional and Windows Vista the default location for 
FactoryTalk activation files is:C:\Users\Public\Documents\Rockwell 
Automation\Activations"

For details, click Help in the top left corner of the page.

Protecting activation files
Activation files are simple text files that must have a .lic extension. The 
activation key for RSView32 Messenger Pro is called RSVMSGR.PRO.
As long as the .lic extension is retained, you can copy or rename an activation 
file without harming it. However, tampering with text inside the activation file 
can disable your Rockwell Software products.
If an activation file is damaged or deleted, contact Rockwell Automation 
Technical Support.
For safekeeping, keep an original set of your activation files on backup media. 
Use descriptive names for the files, so that you can identify them later, and copy 
them back to the appropriate computers.
Activation files are locked to the Host IDs of the computers (or dongles) that 
need them. Activation will fail for Rockwell Software products on a computer 
where the specified Host ID is not recognized by the activation file.

Using borrowed activations
RSView32 Messenger Pro supports borrowed activations for development 
computers. A borrowed activation is retrieved from a pool of available 
activations on the activation server, and expires after a specified length of time. 
Once a borrowed activation is checked out to a particular computer, the 
computer can disconnect from the network. When the time limit expires, the 
associated software on the computer is no longer activated, and the activation 
automatically becomes available again from the server’s activation pool. A 
borrowed activation can also be returned to the activation server manually 
before the time limit expires.
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To borrow activations from a server:
1. Connect your computer to the network where the activation server is 

located.

2. Run the FactoryTalk Activation Manager and then click the Manager 
Activations tab.

3. Click the Manage Activations tab, and then click Borrow Activations 
tab.To borrow a single activation, click the checkbox that corresponds to 
the activation you want to borrow, and then click Set Borrow Term. To 
borrow more than one activation, click additional checkboxes for the 
activations you want to borrow and then click Borrow. If you do not see 
the activations you want to borrow, click I Don’t See My Activation 
Here. The Activations in gray may not be selected as they are already 
borrowed by your computer.
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4. In the Set Borrow Term window, set the time of the return by entering a 
calendar date, net number of days, or approximate hours (shift). The 
default Calendar date is the maximum borrow term for the activation or 
group of activations.

To return a borrowed activation before it expires:
1. Connect to the network and run the FactoryTalk Activation Manager. 

2. On the Manage Activations tab, click Return Activations, select the 
borrowed activations you want to return.

3. Click the Return Activations button.

To open the Activation Help:

To open FactoryTalk Activation Help. Open FactoryTalk Activation Manager, 
click Help or Learn More . . .
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FactoryTalk® Activation Grace Period
FactoryTalk® Activation provides customers with access to critical software 
components for a grace period of 7 days regardless of the availability of valid 
activations. When a product is successfully activated, all grace period records 
will be cleared and the product will proceed with valid activations.

 During the RSView32 Messenger grace period, FactoryTalk® Activation 
will display a Grace Period warning message box to the user and log a 
diagnostic warning message to FactoryTalk® Diagnostics every four hours 
if no valid activation key is detected.

 When the  grace period expires, Messenger will continue to run as in the 
grace period until it is restarted; however, after RSView32 Messenger  is 
restarted, the dial-in and email feature will not be supported.

Starting RSView32 Messenger
When you have installed Messenger, a folder containing three editors appears 
in the RSView32 Program Manager. Double-click any editor to open it; or 
right-click an editor, and then click Show.   

For information about using these editors, see Chapter 2, Getting started. Or, see 
Help.
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Chapter

2 Getting started

Welcome to RSView32 Messenger
RSView32 Messenger™ is an optional extension to RSView32™, for creating 
and using customized voice and text alarm messages and reports. You can send 
alarm messages and reports to plant speakers connected to sound or voice 
cards, to pagers, e-mail addresses, fax machines,  telephone numbers, 
mobilephones and to RSView32 Active Display Client computers.

You can use RSView32 security to prevent unauthorized access to RSView32 
Messenger and Messenger commands at run time. See RSView32 Help for 
information about setting up security.

Additional features with Messenger Pro
If you purchase an RSView32 Messenger Pro™ license, you can use these 
additional features:

 Send file attachments with e-mail notifications.

 Dial in using a regular phone line, to hear and respond to alarms, hear status 
phrases, or run RSView32 commands or macros.

You must activate the Messenger Pro license on your run-time system, as 
described in Chapter 1, Installing RSView32 Messenger.
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The Messenger editors
The Messenger folder in the RSView32 Project Manager contains three editors. 

Use Messenger Setup to:

 set up how the voice will sound (using text-to-speech software).

 select tags to monitor for alarms.

 record and import sounds, words, and phrases.

 set up security for dial-in access, including the greeting users will hear.

 set up dial-in phone menus that users can select from.

 set up short message service center number and cellphone number that 
users can send short message to specified cellphone.

Use Messenger Destination Setup to:

 set up the destinations (telephones, pagers, faxes, e-mail, sound card 
speakers, voice card speakers, cellphone and RSView32 Active Display 
Client computers) for alarm messages and reports.

 specify destinations for alarms of different severities and for alarm events.

 specify alarm messages and alarm event messages.

 set up a schedule for who’s on call to receive alarms or reports during the 
week, on weekends, and on holidays.

 specify which days are statutory holidays, and which days are special 
holidays that relate to your plant or business.

Use Messenger Reports to create reports about alarm activity and other tag 
activity.
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Setting up how messages sound
Messenger comes with text-to-speech conversion software that automatically 
provides spoken versions of all RSView32 tag names and logging messages. 
You can also record messages yourself, and then include them in alarm 
messages and reports. If you want to use text-to-speech, you can choose 
whether the text-to-speech voice is male or female, and you can provide 
pronunciations for unusual or industry-specific words.

Using the RSView32 Messenger sample project
Installing Messenger also installs a sample project that you can use to see how 
Messenger is set up and to test the program before using it with your own 
projects. 

To see Messenger data in action, and to get ideas for setting up your own 
projects to use Messenger, open the RSView32 Messenger sample project.

To open the sample project

 Click the Windows® Start button, and then select Programs>Rockwell 
Software>RSView32 Messenger>RSView32 Sample Messenger Project 
(Messengerdemo.rsv).

Quick start steps
The following steps explain how to get up and running with Messenger. To 
work with Messenger, you must complete step 1. The other steps are optional 
and can be completed in any order.

For more detailed information than is provided in this manual, see Help.

Step 1    Set up communications
To start using Messenger right away, all you need to do is install a sound card 
and issue the MessengerOn command.

If you want to use Messenger to send alarm notification or reports to pagers, 
e-mail addresses, fax machines, phone numbers, cellphones or RSView32 
Active Display Client computers, set up destination information in Messenger 
for each communication method you plan to use. Then test communications 
to ensure everything is set up correctly.
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Set up destinations in the Destinations tab of the Messenger Destination Setup 
editor.

For details, see Chapter 3, Setting up communications.

Step 2    Set up alarm monitoring
You can specify which tags are monitored for alarms, as well as where and 
when different alarm messages are sent.

 By default, Messenger monitors and announces alarms for all the tags in the 
RSView32 tag database for which you have defined alarms. To change the 
default, you can select individual tags to monitor.

Specify the tags to monitor in the Alarm Tags tab of the Messenger Setup 
editor.

 You can send alarm messages to different destinations for different alarm 
severities or events. For example, you can route all Severity 1 alarms that 
remain unacknowledged for 60 seconds to a plant-floor supervisor’s cellular 
phone, while routing alarms of all other severities to destinations according 
to a schedule. At the same time, you can set up Messenger to announce 
every alarm acknowledgement over the plant’s loudspeakers.

Specify the destinations for messages for different alarm severities and 
events in the Alarm Severities tab of the Messenger Destination Setup 
editor.

 You can set up a schedule to specify which destinations receive calls at 
certain times of day, over the weekend, or on holidays.

Set up schedule details in the Schedule and Holiday Setup tabs of the 
Messenger Destination Setup editor.

For details, see Chapter 4, Setting up alarm monitoring.

Step 3    Set up phrases, messages, and reports
You can use Messenger to announce customized alarm messages, issue 
message announcements that you create at run time, or deliver pre-defined 
reports at regular intervals. You can control what form the information appears 
in, and even how it sounds.
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 You can use the text-to-speech software that ships with Messenger to 
customize how audio message announcements sound. You can select from 
a variety of synthesized male and female voices, and control how unusual or 
industry-specific words are pronounced.

Set up the text-to-speech software in the Setup tab of the Messenger Setup 
editor.

 You can create and import audio recordings to use in your messages and 
reports. For example, you can record a tag name description to include in a 
message. Or you can import a bell tone to use at the beginning and ending 
of message announcements.

Create and import audio recordings in the Audio Recordings tab of the 
Messenger Setup editor.

 You can use the specific in-alarm, out-of-alarm, and acknowledge messages 
that have been set up for each tag in RSView32, or you can use standard 
messages that you set up in Messenger. You can also set up standard 
messages for alarm faults and alarm suppression events.

Specify the alarm messages to use in the Alarm Messages tab of the 
Messenger Destination Setup editor.

 You can create reports for many purposes. For example, you can create a 
report about the operational status of the plant, and then e-mail the report 
to shift supervisors and management. Or you can keep people up-to-date 
by regularly sending a status report—for example, once every hour—to one 
or more pagers or telephone numbers.

Set up reports in the Reports editor.

 At run time, you can create messages to report current plant activity. These 
messages, which are generally shorter than your pre-defined reports, are 
called “phrases.”

Type phrases on the command line, using the MessengerPhrase command.

For details, see Chapter 5, Setting up phrases, messages, and reports.

You can issue Messenger commands from the command line, or include them 
in an event, a macro, VBA code, or anywhere else that RSView32 commands 
are used.
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Step 4    Set up dial-in access
If you purchase a Messenger Pro license, you can set up dial-in access to allow 
operators to phone in to hear and respond to alarms, hear status phrases, or run 
RSView32 commands or macros.

 You can use the pre-defined greeting and log-in prompts provided with 
Messenger Pro, or create your own audio prompts.

Set up a greeting and log-in prompts in the Phone Security tab of the 
Messenger Setup editor.

 You can customize the pre-defined menu system, which provides the caller 
with a main menu and submenus to choose from, and you can create a 
custom menu for issuing commands and macros or playing recorded 
phrases.

Set up phone menus in the Phone Menus tab of the Messenger Setup editor.

For details, see Chapter 6, Setting up dial-in access.
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Chapter

3 Setting up 
communications

Quick start
To start using RSView32 Messenger™ right away, all you need to do is install a 
sound card and issue the MessengerOn command. 

To issue the command, start your RSView32™ project, and then on the 
command line type MessengerOn. 

To test that Messenger is working and the sound card is installed properly, on 
the command line type this:

MessengerPhrase “Testing sound card”

When you use this quick start method, Messenger:

 announces alarm messages over the local Windows® sound card.

 monitors and announces alarms for all RSView32 tags for which alarms are 
defined.

 uses the default alarm messages in the Alarm Messages tab of the 
Messenger Destination Setup editor (not the alarm messages that have been 
set up for the tags in RSView32, if any).

 uses the default text-to-speech pronunciation for tag names and 
descriptions.
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Setting up destinations
In addition to sending alarms or reports to speakers attached to a computer’s 
sound card, you can send alarm messages or reports to people who are not on 
the plant floor. Destinations you can use include e-mail addresses, the phone 
numbers of pagers, telephones, cellular phones, and fax machines, and 
RSView32 Active Display Client computers. 

To add a destination, use the Destinations tab in the Messenger Destination 
Setup editor. 

Choose where
to send 
messages and
reports...

...and then fill 
in the details 
about the 
destination.
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Setting up pager destinations
Before you set up pagers in Messenger, install a modem and set it up to dial out 
of your building correctly.

1. In the Destinations tab in the Messenger Destination Setup editor, click 
Add, and then type a name for the destination.

2. In the Destination type box, select Pager.

3. Click Import, and then select the pager service you use.

If your pager service is not listed, click New and set up the pager service 
using the configuration details provided by your service.

4. In the PIN number box, type your pager number.

5. In the Pager service box, select your pager service.

6. Click Retries, type the number of times to retry the pager before giving up, 
and then click OK to close the dialog box.

7. Click OK to save your changes.

8. Start your RSView32 project, and then on the command line type 
MessengerOn.

9. To test that the pager is set up properly, on the command line type this:

MessengerPhrase “Testing pager” /dPagerDestinationName

If the pager destination is set up properly, the phrase “Testing pager” will 
appear on your pager. If you do not receive a response from your pager, go 
back to step 1 and verify your settings. You can also verify the settings with 
your pager company.
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Setting up fax destinations
Before you set up fax destinations in Messenger, connect your computer’s fax-
modem to a COM port.

1. In the Destinations tab in the Messenger Destination Setup editor, click 
Add, and then type a name for the destination.

2. In the Destination type box, select Fax.

3. In the Number box, type the phone number for the fax machine. If you 
have to dial 9 to get an outside line, type a 9 and a comma before the 
number.

For example, type 9,555-1212.

4. In the Initialization box, type the initialization string to send to the fax 
modem, if one is required.

5. In the Connect using box, select the COM port to which your fax-modem 
is connected.

6. Click OK.

7. Start your RSView32 project, and then on the command line type 
MessengerOn.

8. To test that the fax destination is set up properly, on the command line 
type this:

MessengerPhrase “Testing fax” /dFaxDestinationName

If the fax destination is set up properly, the phrase “Testing fax” will 
appear on a fax sent to you. If you do not receive a message on your fax 
machine, go back to step 1 and verify your settings.
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Setting up e-mail destinations
Messenger requires the use of a local area network to send e-mail.

1. In the Destinations tab in the Messenger Destination Setup editor, click 
Add, and then type a name for the destination.

2. In the Destination type box, select E-mail.

3. In the E-mail address box, type the full e-mail address. For example, 
yourname@yourcompany.com. (For testing purposes, set up a destination 
that uses your e-mail address first.)

4. In the E-mail Subject box, type a subject line for the e-mail, if desired. 

This subject line will be used for all alarm messages sent to this destination. 
You can include phrases and tag properties in the subject line.

5. To insert a tag property or pre-recorded phrase in the subject line, click 
Browse and then select a property or phrase from the Phrase Components 
dialog box. 

For more information, see the next section.

6. If you purchased an RSView32 Messenger Pro™ license and want to send a 
file attachment with the e-mail, type or select the name of the file to send.

For example, you might want to send an alarm log file.

To use file attachments, Messenger Pro must be activated on the run-time 
computer. For information about activating Messenger Pro, see Chapter 1, 
Setting up communications.

7. Click OK.

8. Start the program you use to send e-mail (with a current Internet 
connection).

9. Start your RSView32 project, and then on the command line type 
MessengerOn.

10. To test that the e-mail address is set up properly, on the command line type 
this:

MessengerPhrase “Testing e-mail” /dEmailDestinationName

11. Check your “Sent Items” folder. E-mails sent by Messenger should appear 
here within a few seconds.

12. After a few minutes, check your Inbox.
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If the e-mail destination is set up properly, the phrase “Testing e-mail” will 
appear in an e-mail sent to you. If you do not receive an e-mail response, 
go back to step 1 and verify your settings.

Inserting tag properties and recordings
To insert tag property or audio recording into an e-mail subject line, position 
the cursor where you want to insert, and then click the Browse (...) button to 
open the Phrase Components dialog box.     

At run time, when an alarm message is announced, Messenger sends an e-mail 
message with the specified information in the subject line. The current values 
of tag properties are displayed. The names of audio recordings are displayed. 
The e-mail message does not play audio recordings.

To insert a recording, click the Audio 
Recordings tab.

To insert the property for a specific tag, type the tag name here, or 
click Browse (...) to open the Tag Browser, and then select a tag.

To include a property in the subject 
line, double-click it. If you are 
inserting the property for a specific 
tag, first specify the tag in the Tag 
box. 
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Setting up phone destinations
Before you set up phone destinations in Messenger, install an Intel® Dialogic®

ProLine/2V, Intel Dialogic D/4PCI, Intel Dialogic D/4PCIUF, or Intel 
Dialogic D/4PCIU4S voice card. 

Messenger supports channels 1 and 2 on the D/4PCI voice card. 

1. In the Destinations tab in the Messenger Destination Setup editor, click 
Add, and then type a name for the destination.

2. In the Destination type box, select Voice card phone out.

3. In the Number box, type the phone number to dial. If you have to dial 9 to 
get an outside line, type a 9 and a comma before the number.

For example, type 9,555-1313.

4. In the Channel box, select a channel on the voice card. If you also set up a 
voice card speaker destination, Channel 2 is automatically used for that 
destination.

5. Click OK.

6. Start your RSView32 project, and then on the command line type 
MessengerOn.

7. To test that the phone is set up properly, on the command line type this:

MessengerPhrase “Testing phone” /dPhoneDestinationName

If the phone destination is set up properly, you will hear the phrase 
“Testing phone” in a phone call to you. If you do not receive a phone call, 
go back to step 1 and verify your settings.
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Setting up sound card speaker destinations
Before you set up sound card speaker destinations in Messenger, install a sound 
card and speakers.  

1. In the Destinations tab in the Messenger Destination Setup editor, click 
Add, and then type a name for the destination.

2. In the Destination type box, select Sound card speakers.

3. In the Voice box, select the speaker voice. If you select the default, the 
speaker voice used is the one you select in the Messenger Setup dialog box.

4. Click OK.

5. Start your RSView32 project, and then on the command line type 
MessengerOn.

6. To test that the sound card speaker destination is set up properly, on the 
command line type this:

MessengerPhrase “Testing sound card” /dSoundcardDestinationName

If the sound card speaker destination is set up properly, you will hear the 
phrase “Testing sound card” on the speakers using the speaker voice you 
selected. If you do not receive a response on the speakers, go back to 
step 1 and verify your settings.
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Setting up voice card speaker destinations
Before you set up voice card speaker destinations in Messenger, install a voice 
card and speakers.  

Messenger supports the Intel Dialogic ProLine/2V voice card and the D/4PCI 
voice card, the Intel Dialogic D/4PCIUF and Intel Dialogic D/4PCIU4S voice 
card. Channel 2 is used for the voice card speaker destination. You cannot 
select a different channel.

1. In the Destinations tab in the Messenger Destination Setup editor, click 
Add, and then type a name for the destination.

2. In the Destination type box, select Voice card speakers.

3. Click OK.

4. Start your RSView32 project, and then on the command line type 
MessengerOn.

5. To test that the voice card speaker destination is set up properly, on the 
command line type this:

MessengerPhrase “Testing voice card” /dVoicecardDestinationName

If the voice card speaker destination is set up properly, you will hear the 
phrase “Testing voice card” on the speakers. If you do not hear a message 
on the speakers, go back to step 1 and verify your settings.
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Setting up short messeage service destination
Before you set up short messeage service destinations in Messenger, specify 
comm port, baud rate and short messeage service number in Messenger Setup 
editor, SMS Setting tab.

1. In the Destinations tab in the Messenger Destination Setup editor, click 
Add, and then type a name for the destination.

2. In the Destination type box, select Short Message Service.

3. Click OK.

4. Start your RSView32 project, and then on the command line type 
MessengerOn.

5. To test that the short message service destination is set up properly, on the 
command line type this:

MessengerPhrase “Testing short message service” /dCellphoneDestinationName
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Setting up the Active Display Client
To set up an RSView32 Active Display Client as a destination in Messenger, 
you must also set up a graphic display using RSView32. The graphic display 
must contain an ActiveX® control called RSView32 Messenger Client Control. 
Create the graphic display containing the RSView32 Messenger Client Control 
using the Graphic Display editor.

At run time, the display must be displayed and running in the background on 
the client computer. The server sends alarm messages and reports to the client 
through string tags.

Before you set up the RSView32 Active Display Client as a destination, check 
that the client and the server are working properly. 

1. In the Destinations tab in the Messenger Destination Setup editor, click 
Add, and then type a name for the destination.

2. In the Destination Type box, select Active Display Client.

3. To specify the string tag that stores the voice name you want to use, click 
Browse (...). In the Tag Browser, select the string tag.

For example, to use the text-to-speech voice called Mary, create a string tag 
with the value Mary. Select this tag in the box.

4. Select a string’s row in the table, from 1 to 10, and click Browse (...) to 
select a string tag that stores the alarm message or report. 

You can specify a maximum of 10 string tags, with up to 82 characters for 
each.

5. In RSView32, perform the following steps:

 In the Graphic Display editor, create a new display. For detailed 
instructions, see the RSView32 Help.

 Add an RSView32 Messenger Client Control object.

 Right-click the RSView32 Messenger Client Control object, and then 
click ActiveX Property Panel. 

 In the Animation tab of the ActiveX Property Panel, select the string 
tags you specified in steps 3 and 4 (such as, Message and Voice).

 In the Properties tab of the ActiveX Property Panel, change the voice if 
you want to use a different voice. To do this, double-click the Voice 
property, and then type the name of the voice to use.
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 Right-click the graphic display, and then click Display Settings. Set the 
Cache After Displaying option to Yes, and select Always Updating.

or

If you do not want the graphic display to be visible on the RSView32 
Active Display Station, use the Display /ZA command for the display. 
Messenger announces any changes in the tags that are continuously 
being updated. Those tags are specified in the Messenger Destination 
Setup editor. For more information about the Display /ZA command, 
see the RSView32 Help. 

 Save the graphics display file. 

 Create a startup macro that clients can use to display the graphic display 
containing the RSView32 Messenger Client Control object. For more 
information about creating macros, see the RSView32 Help.

Important: Do not use the FlushCache command. This command 
removes the graphic display from the cache at the client. For more 
information about the FlushCache command, see the RSView32 Help.

6. In the Messenger Destination Setup editor, click OK.

7. Start your RSView32 project, and then on the command line, type 
MessengerOn. 

8. Start the RSView32 Active Display Station to open the graphic display file. 

The RSView32 Messenger Client Control monitors the specified string 
tags, plays the alarm message or report, and clears the string tags.

9. To test that the client destination is set up properly, on the command line 
type this:

MessengerPhrase “Testing Active Display Client” /dClientDestinationName

If the RSView32 Active Display Client destination is set up properly, you 
will hear the phrase “Testing Active Display Client” on the speakers. If you 
do not receive a response on the speakers, go back to step 1 and verify your 
settings.

Important: If you view the graphic display file containing the RSView32 
Messenger Client Control object from the web browser, you must open a new 
web browser window to view another graphic display file. 
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Turning destinations on and off at run time
You can turn destinations on and off using the MessengerDestinationEnable 
and DestinationDisable commands. When you first start Messenger, all 
destinations are turned on. 

See RSView32 Help for information about providing operators with ways to 
issue commands at run time. See RSView32 Messenger Help for more 
information about Messenger-specific commands.
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Chapter

4 Setting up alarm 
monitoring

Specifying tags to monitor
By default, RSView32 Messenger™ monitors and announces alarms for all the 
tags in the RSView32™ tag database for which you have defined alarms. To 
change the default, you can select individual tags to monitor.

Whether to use all alarm tags depends on how frequently you expect alarms to 
be generated. For example, if you choose to announce alarms for all tags, 
alarms might be generated faster than they can be communicated to a 
telephone, or, if you send alarms by e-mail, the number of alarms generated 
might bring down the e-mail system. 
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To specify the tags for which alarms will be announced, use the Alarm Tags tab 
in the Messenger Setup editor.  

To limit the number of tags 
Messenger monitors, click here.

View details about the 
selected tag here. To hear 
what the text in the box will 
sound like when spoken, click 
Play (the button with the green 
arrow on it).

To add a tag to the 
list, click Add.
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Specifying destinations for alarm severities and 
events

You can send alarm messages to different destinations for different alarm 
severities and events. 

To assign destinations to alarm severities or events, use the Alarm Severities tab 
in the Messenger Destination Setup editor.  

If you choose No destination for alarm severities or events, notification of the 
alarm severity or event is not sent. For example, you might not want 
notification to be sent when alarms are acknowledged. In this case, you would 
set the Acknowledged event to No destination.

Acknowledging alarms
If you purchased an RSView32 Messenger Pro™ license, operators can 
acknowledge alarms by dialing in to the run-time computer. Users can listen to 
and acknowledge single alarms, or acknowledge all alarms. For more 
information, see Chapter 6, Setting up dial-in access.

Click an alarm severity or 
event...

...and then choose whether to specify the 
destination or use the schedule to determine 
the destination.

If you choose to specify the 
notification, set it up here.

To display and select destinations,
click Browse (...) to open the Select

Destinations dialog box.
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Setting up notifications and destinations
For each alarm severity, you can set up three notifications, or you can let the 
schedule determine which destinations will receive alarm notification. To set up 
a notification, specify the time (in seconds) when the notification will take 
place, and choose one or more destinations where the notification will be sent. 

Similarly, for each alarm event you can either set up three notifications that will 
be sent to one or more destinations at a specified time, or you can let the 
schedule determine which destinations will receive alarm notification.

To assign destinations, click the Browse (...) button to open the Select 
Destinations dialog box. You can specify up to 25 destinations.

Click the check
boxes to select a

destination or
multiple

destinations.



Setting up alarm monitoring     33

Setting up continuous notification and 
announcements
For alarms, you can set up continuous notification. Messenger continues to 
send you notifications until the alarm is acknowledged. You can specify how 
often you want notification and assign destinations.

For acknowledged alarms, you can set up Messenger to announce the 
acknowledgement only if the tag is still in alarm at the time of the 
acknowledgement.

Specify the notification time, between 1 
and 99999 seconds. Click Browse (...) 
to open the Select Destinations dialog 
box.

Click to send further 
notifications until 
the alarm is 
acknowledged.

Select to announce the acknowledgement 
of a tag in alarm at the time of the 
acknowledgement. Clear the check box to 
announce all alarm acknowledgements.
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Setting up a schedule
You can set up a schedule to specify which destinations receive calls at certain 
times of day, over the weekend, or on holidays. 

For example, you can set up the system so that alarms are announced over 
speakers attached to a computer’s sound card from Monday to Friday, between 
the hours of 8 A.M. and 6 P.M., and you can have alarms announced via the 
phone to one or more people who are on call evenings and weekends.

You can also specify different alarm destinations for statutory and special 
holidays. For details, see “Setting up holidays” on page 36.

To set up a schedule for alarm notification, use the Schedule tab in the 
Messenger Destination Setup editor.  

When you double-click a cell in the schedule, the Schedule Detail dialog box 
opens so you can specify which destinations receive notification of an alarm if 
it remains unacknowledged for a certain period of time. You can specify up to 
25 destinations for each notification.

To assign the same destinations to multiple time periods, select the cells for the 
time periods, and then click Edit. 

To edit a cell, 
double-click it.

To see the schedule for 
holidays, click Show holidays.
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For alarms, you can set up continuous notification. Messenger continues to 
send you notifications until the alarm is acknowledged. You can specify how 
often you want notification and assign destinations.

For acknowledged alarms, you can set up Messenger to announce the 
acknowledgement only if the tag is still in alarm at the time of the 
acknowledgement.

Select the check box 
to announce the 
acknowledgement 
only if the tag is in 
alarm at the time of the 
acknowledgement. 
Clear the check box to 
announce all alarm 
acknowledgements.

To display and 
select destinations, 
click Browse (...) to 
open the Select 
Destinations dialog 
box.

Click to send notifications 
until the alarm is 
acknowledged.

Specify the notification time, 
between 1 and 99999 seconds. 
Click Browse (...) to open the 
Select Destinations dialog box.
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Setting up holidays
You can set up dates that will use the statutory holiday or special holiday 
schedules. If a date is assigned to one of the holiday schedules, on this date 
Messenger uses the holiday schedule instead of the regular schedule. You can 
assign any dates to a statutory holiday schedule or special holiday schedule. A 
special holiday is a day off scheduled by the company. 

Select Statutory 
Holiday or 
Special Holiday.

Type the date of 
the holiday.

Click to import a group of 
statutory holidays. Follow the 
instructions in the wizard.

To add a single holiday to the 
Select holiday list, click Add. To 
remove a holiday, click Delete.
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5 Setting up phrases, 
messages, and reports

Setting up text-to-speech

What is text-to-speech?
Text-to-speech is software for translating text so that it can be spoken by a 
synthesized human voice. RSView32 Messenger™ comes with Microsoft® text-
to-speech software, but you might be able to use Messenger with SAPI-
compliant text-to-speech software from other manufacturers. (SAPI is the 
Speech Application Programming Interface.)  

The text-to-speech voice is used with sound cards or voice cards when sending 
alarm messages and reports to audio destinations. You can test how text-to-
speech pronounces your messages and reports as you set up your project.

Bypassing text-to-speech
You do not have to use the text-to-speech voice to produce audio messages. 
You can create your own audio recordings and import .wav files in the Audio 
Recordings tab of the Messenger Setup editor. Messenger saves your 
recordings in .wav format. For details, see “Creating and importing audio 
recordings” on page 40.

Customizing text-to-speech
The Microsoft text-to-speech software is already set up with default values that 
are suitable for most projects. You can customize these settings:

 the text-to-speech voice

 the pronunciation of unusual or industry-specific words that are not part of 
the text-to-speech software’s normal vocabulary
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To set up the text-to-speech software, use the Setup tab in the Messenger Setup 
editor.   

Choosing a text-to-speech voice
The default voice is called Mary. Test the default voice to see if it is suitable for 
your project. While experimenting with voices, use these tips:

 Use a male (lower-pitched) voice in spaces where there is little or no echo; 
use a female (higher-pitched) voice in spaces where there is a lot of echo.

 The higher the volume, the more difficult it is to understand what the voice 
is saying. Keep the volume level at the lowest audible setting.

 Test the voice in different settings. Choose a voice that sounds natural and 
life-like while adapting to the environment in which it will be used.

Specifying the pronunciation of words
The text-to-speech software cannot always correctly pronounce words such as 
company names, the names of people and places, technical terms, and so on. 
For these words,  you will need to define or correct the pronunciation before 
using them in messages and reports. 

Click here to 
choose a text-to-
speech voice.

If you use the Microsoft text-to-speech 
conversion software that comes with 
Messenger, the Setup button displays 
the software version, and the Translation 
button is inactive.

Click here to add 
or change the 
pronunciation of 
words.
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Specify how to pronounce the word by breaking it into syllables.   

For the changes in pronunciation to take effect, you have to stop and then start 
the RSView32™ project.

For additional tips, see “Working with text-to-speech software” in the 
Messenger Help.

Type the word for 
which to define 
pronunciation 
here...

...and then click 
Next.

Type short words
that have the 
same sound as the
syllables of the 
word you are 
defining.

When the word 
sounds right, click
Finish.

Click Play to hear
how the word 
sounds.
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Creating and importing audio recordings
You can record words and phrases to use in your messages and reports. A 
microphone is required to create audio recordings. You can use these 
recordings in addition to or instead of messages spoken by the text-to-speech 
voice.

Audio recordings are stored as .wav files. You can also import .wav files and 
use them in your messages and reports. For example, you might use the 
Windows® system file Chord.wav to signal the beginning and end of a report.

To create, import, or re-record audio recordings, use the Audio Recordings tab 
in the Messenger Setup editor.   

To import a .wav file, click Import.

3. To make an audio recording, select the item in 
the list, then click Record (red circle). Click Stop 
(white rectangle) to stop recording. Click Play 
(green arrow) to hear how the recording sounds.

2. If an item has been added to the list 
but nothing has been recorded yet, a 
loudspeaker with a red X appears 
next to the item.

1. To create an audio recording item, click 
Add, and then type a name and click OK.
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Specifying and creating alarm messages
You can use the custom in-alarm, out-of-alarm, and acknowledge messages 
that have been set up for each tag in RSView32, or you can use standard 
messages that you set up in Messenger. You can also set up standard messages 
for alarm faults and alarm suppression events, whether or not you use the 
custom RSView32 alarm messages.

To specify or create alarm messages, use the Alarm Messages tab in the 
Messenger Destination Setup editor.  

When you create alarm messages in this editor, you can include tag properties 
for a specific tag or for the tag that is in alarm. You can also include audio 
recordings, and type plain text. 

You can specify alarm event messages 
here even if you use the RSView32 tags’ 
alarm messages.

Click Play (green arrow) 
to hear how a message 
sounds.

To insert a tag property or audio 
recording into the message, click 
Browse (...) to open the Phrase 
Components dialog box.

To use the custom messages set up for each tag in 
RSView32, click Use custom file messages or Use custom 
printer messages.
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Inserting tag properties and recordings
To insert a tag property or audio recording into a message, position the cursor 
where you want to insert, and then click the Browse (...) button to open the 
Phrase Components dialog box.     

At run time, when an alarm message is announced, the text-to-speech software 
speaks the plain text and the current values of the tag properties, and 
Messenger plays the audio recordings.

To insert a recording, click the Audio 
Recordings tab.

To insert the property for a specific tag, type the tag name here, or 
click Browse (...) to open the Tag Browser, and then select a tag.

To include a property in the report, 
double-click it. If you are inserting the 
property for a specific tag, first 
specify the tag in the Tag box. 
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Creating reports
You can create reports about alarm activity and other plant activity using any 
combination of plain text, tag properties, and audio recordings. 

To create reports, use the Messenger Reports editor.   

As with alarm messages, to insert tag properties or audio recordings use the 
Phrase Components dialog box, shown in the previous section.

When you are finished creating the report, save it by choosing File>Save from 
the RSView32 menu bar. Use the report’s file name, without the .vrp extension, 
when you send the report at run time.

Using reports at run time
At run time, you can send a report to any destination by using the 
MessengerReport command. For example, to send a report called Oventemp 
to a destination called Supervisors E-mail, type this:  

MessengerReport Oventemp /dSupervisors E-mail

If you do not specify a destination, the report is announced using the speakers 
connected to the local Windows sound card. The report will contain the values 
of tag properties at the time the command is issued. If you specify tags in the 
report, the values for the specified tags will be used. If you do not specify tags, 
the values for the most recent tag that is in alarm will be used.

Type the text to use in your report. With the 
cursor positioned where you want to insert a 
tag property or audio recording...

... click Browse (...) 
to open the Phrase 
Components dialog 
box, and then 
double-click the 
property or 
recording to insert.

To listen to your 
report, click Play.
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Creating phrases at run time
At run time, you can create messages to report current plant activity. These 
messages, which are generally shorter than your pre-defined reports, are called 
“phrases.”  

Type phrases on the command line, using the MessengerPhrase command.

For example, to send the current value of the tag called Oventemp to a 
destination called Pager, type this:

MessengerPhrase “The oven has reached [Oventemp.Value] degrees.” 
/dPager

If you do not specify a destination, the phrase is announced over the local 
Windows sound card.

For details about formatting your phrases correctly, see “Phrase components 
syntax” in Messenger Help.



 45

Chapter

6 Setting up dial-in access

Using dial-in access
Dial-in capabilities are available at run time only if the run-time system has an 
RSView32 Messenger Pro™ license, which must be purchased in addition to 
RSView32™. You must activate the Messenger Pro license on your run-time 
system. 

For information about activating Messenger Pro, see Chapter 1, Installing 
RSView32 Messenger.

Operators can dial in to:

 listen to alarms

 acknowledge alarms, either singly or all at once

 play a Messenger phrase

 run an RSView32 command or macro

Dialing and logging in
Operators must have a numeric user ID and a numeric password to log into 
the system. Set up user names and passwords in the RSView32 User Accounts 
editor. 

To dial and log in

1. Dial the phone number of the phone line to which the run-time computer 
is connected. 

2. Type your numeric user name, and then press the # key.

3. Type your numeric password, and then press the # key.

4. Listen to the voice prompts and make your selections using the numeric 
keypad on your touch-tone phone.

The options available depend on how you set up the dial-in phone menus.
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Preparing the voice card and setting up a greeting
To prepare the voice card for dial-in access and set up a greeting, use the Phone 
Security tab in the Messenger Setup editor.   

Messenger supports phoning in using the Intel® Dialogic® ProLine/2V, Intel 
Dialogic D/4PCI,  Intel Dialogic D/4PCIUF and Intel Dialogic D/4PCIU4S 
voice cards. The ProLine/2V card has 2 channels. Messenger supports 
channels 1 and 2 on the D/4PCI card.

If you are using the voice card speaker destination, that destination occupies 
channel 2.

Type the number of the channel on 
the voice card to use for dial-in 
access.

Type a greeting here, 
and prompt the user to 
enter a numeric user 
name and password. 
The user must press 
the # key after entering 
each number.

Check this box to set 
up the voice card for 
dial-in access.

To insert a tag property or audio 
recording into the message, click 
Browse (...) to open the Phrase 
Components dialog box.
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Setting up phone menus
You can set up these options for the dial-in phone menu: 

 a welcome message that the user hears once logged in successfully

 an exit message that plays before disconnecting

 the options on the Main Menu

 the options on the Alarm Menu

 the options on the Commands Menu

 the error message that is spoken if the user enters the wrong number or 
doesn’t respond to the voice prompts quickly  

To set up options for the phone menus, use the Phone Menus tab in the 
Messenger Setup editor. 

Setting up voice prompts for the phone menus
You can set up separate voice prompts for each of the menus you plan to use. 
The prompts tell users which buttons to press to select menu items.  

Type an exit 
message to play 
before the user 
hangs up.

Check this box to play 
a welcome greeting 
when the user has 
logged in. Type the 
greeting in the box.

Cick here to set up messages for 
when the user enters an invalid 
digit or doesn’t respond to the 
voice prompts. Type the 
messages in the dialog box that 
opens.

Check the boxes for 
the phone menus you 
want to use. Type the 
menu prompts in the 
text boxes.
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Setting up the Alarm Menu
You can choose which items to include on the Alarm Menu by removing 
unwanted items from the Alarm Menu’s audio prompt.  

The * key on the Alarm Menu is reserved for returning to the Main Menu.

Check this box to 
use the Alarm 
Menu. Remove 
unwanted menu 
items from the 
voice prompt in the 
text box.

Click Details to see the options 
available on the Alarm Menu...

Clear this box if 
you don’t want the 
operator to 
acknowledge all 
alarms from the 
Main Menu.
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Setting up the Commands Menu
You can use the Commands menu to run RSView32 commands and macros, 
or to play Messenger phrases such as messages about tag status.  

The * key on the Commands Menu is reserved for returning to the Main Menu.

Click Modify to set up the options for the 
Commands Menu...

Specify whether to use 
the menu for running 
commands and 
macros, or for playing 
Messenger phrases.

Check the boxes for 
the menu item numbers you 
want to use, then...

...type a command, a macro 
(multiple commands, separated 
by a space or comma), or a 
phrase...

...or click Browse to open the
Command Wizard or the 
Phrase Components dialog 
box.

Check this box 
to use the 
Commands 
Menu. Type a 
voice prompt in 
the text box to 
tell users which 
buttons to press 
to select menu 
items.
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Chapter

7 Getting the information 
you need

Using RSView32 Messenger Help
RSView32 Messenger™ Help provides overviews, reference information, and 
step-by-step procedures for working with all of the features in Messenger. To 
open Help while running RSView32™ you can:

 click the Help button on any window.

 on the RSView32 menu bar, click Help>Contents.
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Viewing the Help contents
For an overview of the Messenger Help, click the Contents tab, and then 
double-click the RSView32 Messenger book. 
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Using the index
The Help index is similar to an index in a book, listing keywords for topics in 
the Help. To see the index, click the Index tab. 

Finding RSView32 Messenger version information
To find the Messenger version number and serial numbers, click Help>About 
RSView32, and then click Add-Ons. In the box, select RSView32 Messenger, 
and then click Details.

Finding information about RSView32
For information about RSView32, refer to these publications:
RSView32 User’s Guide

Rockwell Software, Publication ID VW32-UM001E-EN-E 
RSView32 Runtime User’s Guide

Rockwell Software, Publication ID VW32RT-UM001E-EN-E
RSView32 Getting Results Guide
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Rockwell Software, Publication ID VW32-GR001E-EN-E

These publications are also available on the RSView32 installation CD-ROM 
and from the Programs>Rockwell Software>RSView32>RSView32 User’s 
Guides menu. 

Technical support
If you have a question about Messenger, please consult this guide or the 
RSView32 Messenger Help. Or, click Help, Rockwell Software on the Web, 
and then click the name of the web page you want to view. To use Rockwell 
Software on the Web, you must have a web browser installed on your computer 
and a current internet connection.

If you can’t find the answers, contact Rockwell Software Technical Support:

Telephone—440-646-3434

World Wide Web Support web site—http://support.rockwellautomation.com

Support staff are available Monday through Friday from 8 A.M. to 5 P.M. 
eastern time, except during holidays.

When you call
When you call, be at a computer and prepared to give the following 
information:

 the product serial number

For RSView32 Messenger Pro, you can find this number on the Activation 
disk label. 

 the product version number

You can find this number online. With the Messenger Setup editor selected, 
click Help, and then click About Messenger Setup.

 the type of hardware you are using

 the exact wording of any messages that appeared on your screen

 a description of what happened and what you were doing when the problem 
occurred

 a description of how you tried to solve the problem
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You might also be required to provide information about other RSView32 
Messenger Pro add-ons and updates that are installed on your computer.

To view the list of installed add-ons and updates

1. With the Project Manager window selected, click Help>About RSView32 
Messenger Pro.

2. Click Add-Ons to view the list of installed add-ons. 

3. Click Updates to view the list of installed updates.
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